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Warning

Musical compositions and artwork are protected under international copyright laws. 
Unauthorized copying of those works may violate the rights of the owner and may 
expose you to civil and criminal penalties. You may not use the Total Recorder 
product to violate the copyright rights of others. High Criteria Inc. does not authorize 
you to use Total Recorder for the purpose of violating the copyright rights of others 
nor does it license or sell Total Recorder to you for this purpose. If you have any 
questions or doubts concerning your use, or copying, of someone else’s works, please 
confirm in advance that you are authorized to use and copy the work in the manner 
you intend.

Trademark Notice

Other product and company names appearing in High Criteria Inc. products and 
materials are used for identification purposes only and may be trademarks or 
registered trademarks of their respective companies. Registered and unregistered 
trademarks used in any High Criteria Inc. products and materials are the exclusive 
property of their respective owners.
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WHAT'S NEW?

Version 3.0

Version 3.0 adds many new features, including the following: 

 The ability to play and record compressed sound using installed codecs.

 The ability to use external MP3 modules for recording in MP3 format.

 Compatibility with Windows Millennium Edition.

 A Fast save capability.

 Automatic stop after a specified amount of recording time.

 Interface improvements.

Warning: Version 3.0 uses a new format of the registration key. When you install this
new version, it will be unregistered until you enter a new registration key.

Version 2.2

In addition to maintenance, Version 2.2 adds the following features: 

 Support for Windows NT 4.0 and Windows 2000. 

 The ability to resample a recording (i.e. change sound stream parameters). 
Resampling can be done either during the recording process or when you save
a recording. 

 The maximum recording size is no longer limited to 2GB. It is now possible 
to record up to 49 continuous days. However, since an individual .wav file has
a limit of 4GB, a long recording must be broken into pieces in order for it to 
be saved.

 A save progress indicator.

 The ability to increase the priority of the Total Recorder program and provide
cleaner recordings.

 The ability to normalize the volume of a recording.  
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Version 2.1

In addition to maintenance, Version 2.1 adds the following features: 

 Accelerated recording/converting. This allows you to convert a sound file to 
standard wave format without listening to it. This operation normally takes a 
fraction of the time it would require to play the file.

 Markers. These allow you to select and save only part of a recording or part 
of an existing wave file.

 The ability to continue recording to the same file after it was stopped.

 A level indicator reflects the amplitude of a signal during recording and 
playback.

 The ability to have more than one open copy of Total Recorder (like in 
version 1.0).

Version 2.0

Version 2.0 adds many new features, including the following: 

 Capturing and recording of sound streams that programs request from a sound
card. This allows full duplex recording of Internet phone conversations when 
using programs such as NetMeeting and VoxPhone.   

 Recording from CD, microphone and other input lines.

 Built-in scheduler that allows you to program jobs (record or playback) to 
start at a given time, similar to programming a VCR.

 Command line parameters that allow you to use an external scheduler such as 
Microsoft Task Scheduler to schedule a recording or playback.

 Automatic installation and uninstallation of the virtual device driver.
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OVERVIEW
Total Recorder is a sound recording and playing program. It records analog sound 
digitized by a sound card, as well as sound generated, or requested, by other computer
programs, such as RealPlayer, Windows Media Player, Quick Time, WinAmp, and 
many others. Recorded sound is saved in wave-file format or you can use external 
programs to save recorded sound using MP3 format. 

For example, you can use Total Recorder to record:

 audio from the Internet, either audio files or live streams

 music from a game program

 a conversation, if you use an Internet telephony program.

Total Recorder uses a virtual sound driver to capture the sound output from another 
program. By installing this driver, and setting this device as the default, different 
sound reproducing programs send their output stream to Total Recorder's driver and 
not to the driver of a real device. Total Recorder then passes the information to the 
sound card driver.

Total Recorder has a built-in scheduler. This allows you to automatically record a 
show at a given time for later playback or you can use the scheduler as an alarm. Note
that this latter function does not require registration.

How Total Recorder Works with Different Sources

The following diagrams illustrate, in more detail, how Total Recorder works with 
different sources of input.

Software Recording

You can capture and record sound played back or requested by other computer 
programs. 
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Software Accelerated Recording/Converting

You can speed up (or down) capturing and recording sound played back other 
computer programs. In this mode you could not hear a sound when a recording is in 
process.

Board Recording

You can record sound digitized by a sound card. This includes a microphone, CD or 
other input lines.

System Requirements

To use Total Recorder, you need the following:

 an IBM compatible computer

 a sound card 

 Microsoft Windows 95, 98, ME (Millennium Edition), or 2000, or Windows 
NT 4.0.
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Program Restrictions

Total Recorder records wave-type sound streams only. It cannot record any of the 
following:

 Sound reproduced by means of MIDI-output, unless your sound card has a 
special MIDI synthesis line (most sound cards have this feature).

 Sound reproduced by programs developed for systems other than Windows 
95/98/Me or NT/2000 (e.g. DOS programs executing in DOS sessions).

Total Recorder can record only one output and one input sound stream at a time. If a 
sound card allows simultaneous output of several wave-streams and can mix these 
streams itself, then Total Recorder can only record one of these streams. 

INSTALLATION AND CONFIGURATION
Total Recorder is shipped via the Internet, as a self-extracting or regular archive, and 
consists of the files listed below. The following table indicates each file name, a 
description, and the environments in which each file is required.

File Description Required on
Windows
95/98/ME

Required on
Windows 2000/NT 4

TotalRecorder.exe Total Recorder 
program

Yes Yes

DrvTR95M.drv device driver Yes No

DrvTRNTM.dll device driver No Yes

DrvTR95L.dll device driver library Yes No

DrvTRNTL.dll device driver library No Yes

DrvTR95.vxd virtual device driver Yes No

DrvTR95.inf driver installation file Yes No

OEMSETUP.inf driver installation file No Yes

TotalRecorder.hlp help file Yes Yes

TotalRecorder.cnt help content file Yes Yes

TRInst.exe install/uninstall 
program

Yes Yes

Total Recorder Page 10



File Description Required on
Windows
95/98/ME

Required on
Windows 2000/NT 4

DrInst.exe driver install/uninstall 
program

Yes No

License.txt license agreement file Yes Yes

Readme.txt read-me first file Yes Yes

TotalRecorder.doc documentation Yes Yes

Registration.txt registration form Yes Yes

Installing Total Recorder

Version 3.0 uses a new format of the registration key. When you install this new 
version, it will be unregistered until you enter a new registration key. The 
“Registering Total Recorder” section describes how to obtain a key, once you have 
installed and configured the software.

Specific Information for Windows NT

To install Total Recorder on Windows NT, you need the “Load and Unload Device 
Drivers” user right. Normally, only administrative users have this right.

To use the Total Recorder program, you do not need any special rights. However, the 
Total Recorder setup program changes settings only for the user who installed the 
program. Any other user must manual set the Total Recorder driver as a preferred 
device (see "Installing/Uninstalling the Total Recorder Driver Manually").

Specific Information for Windows 2000

Windows 2000 is a member of the Windows NT product family. All of the 
information in the previous section (“Installing Total Recorder in a Windows NT 
Environment”) applies to Windows 2000.

If you are planning to upgrade your Windows 95/98 system to Windows 2000, you 
must take the following steps:

1. Before upgrading your Windows environment, uninstall Total Recorder.

2. After the upgrade is complete, reinstall Total Recorder.

3. Re-register Total Recorder. Have you registration information available.
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Note: Total Recorder will not work if you simply upgrade your Windows 
environment to Windows 2000 without taking the steps described above. 

Installation Steps

Version 3.0 cannot coexist on the same machine with any previous version (1.0, 2.0,  
2.1 or 2.2).

Take the following steps to install Total Recorder on your PC:

1. Download the self-extracting archive totrec30.exe 
(http://www.highcriteria.com/download/totrec30.exe) and run it. 

OR

Download the archive totrec30.zip 
(http://www.highcriteria.com/download/totrec30.zip). Unzip it and run 
TRInst.exe.  Note that you must unzip the entire archive not just 
TRInst.exe.  

If you have a previous version installed, you are prompted to uninstall it. Press 
“OK” to continue with the installation. Press “Cancel” if you want to exit the 
installation program without installing the software. 

The installation program creates a directory for Total Recorder, copies all of the 
files to that directory, creates a Program Group called Total Recorder, installs a 
driver, and sets it as the default device for both playback and recording.

2. After installing Version 3.0 over a previous version you must restart Windows. 
Under Windows NT or Windows 2000 you must reboot your PC, even after the 
initial installation. In all cases you will receive a prompt.

Tip:
Create a shortcut to Total Recorder and place it on your desktop. This gives you 
single-click access to Total Recorder. 

Installing/Uninstalling the Total Recorder Driver Manually

If you experience problems with the automatic installation or uninstallation of the 
Total Recorder driver, you can install/uninstall this driver manually as described 
below. Otherwise, skip to the section “Configuring Total Recorder”.

Installing the Driver Manually

You need to install a virtual driver so that Total Recorder is able to record as well as 
play. This process is similar to that used for installing a sound card driver. The 
procedure you use depends on the version of Windows you are running.
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Use the following procedure for Windows 95, Windows 98, or Windows ME:

1. Select “Start”-“Settings”-“Control Panel”. 

2. Click on “Add New Hardware”.

3. For Windows 95: Answer “No” to the question “Do you want Windows to search
for your new hardware?”

For Windows 98/ME: Select “No - I want to select the hardware from a list” to 
the prompt “Windows can search for hardware that is not Plug and Play 
compatible or select from a list”.

4. Select “Sound, video and game controllers” from the list of Hardware types.

5. Click on “Have disk” instead of choosing from the list of manufacturers and 
models.

6. Point to the directory you selected during the installation of Total Recorder (where
DrvTR95.inf resides). 

7. There will only be one driver entry in this .inf file - Wave sound driver for the 
Total Recorder, and it will be selected by default. Click "OK" or press Enter.

8. After clicking the “Finish” button, wait patiently for a wizard dialog window to 
disappear. It may take about one minute.  

Use the following procedure for Windows NT 4.0:

1. Select “Start”-“Settings”-“Control Panel”. 

2. Click on “Multimedia”.

3. Select the “Devices” tab.

4. Click “Add”.

5. Click on “Unlisted or Updated driver” from the list of manufacturers and models.

6. Point to the directory you selected during the installation of Total Recorder (where
oemsetup.inf resides). 

7. There will only be one driver entry in this directory - Wave sound driver for the 
Total Recorder, and it will be selected by default. Click “OK” or press Enter. 

8. After the installation is complete, reboot your computer.
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Use the following procedure for Windows 2000:

1. Select "Start"-"Settings"-"Control Panel".

2. Click on "Add/Remove Hardware".

3. Click "Next" to continue.

4. Select "Add/Troubleshoot a device" and click "Next".

5. Select "Add a new device" and click "Next".

6. Select "No, I want to select the hardware from a list" and click "Next".

7. Select "Sound, video and game controllers" and click "Next".

8. Click on "Have disk" instead of choosing from the list of manufacturers and 
models.

9. Point to the directory you selected during the installation of Total Recorder (where
oemsetup.inf resides).

10. There will only be one driver entry in this directory - Wave sound driver for the 
Total Recorder, and it will be selected by default. Click "Next".

11. Click "Next" again. A "Digital Signature Not Found" dialog appears.

12. Click "Yes". A "Files Needed" dialog appears.

13. Enter the same name as in step 9.

14. Click "Finish".

15. Close all applications and reboot your computer.

Setting preferred devices

After installing the virtual device driver manually, you must set this device as your 
default. 

1. Select “Start”-“Settings”-“Control Panel”. 

2. Select “Multimedia” (for Windows ME and Windows 2000 - "Sounds and 
Multimedia") and click on the “Audio” tab.

3. Review the “Preferred device” list in the “Playback” section. Write down the 
name of the default device and then proceed to the next step. Important: This 
information is required if you uninstall Total Recorder. 
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4. Select the “Playback through Total Recorder” entry.

5. Review the “Preferred device” list in the “Recording” section. Write down the 
name of the default device and then proceed to the next step. Important: This 
information is required if you uninstall Total Recorder. 

6. Select the “Record through Total Recorder” entry.

7.  You should also check the “Use preferred devices only” box.

Uninstalling the Driver Manually

If you need to uninstall the Total Recorder driver manually, take the following steps 
for Windows 95/98/ME:

1. Select “Start”-“Settings”-“Control Panel”. 
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2. Select “System” and click on the “Device Manager” tab.

3. Select “Sound, video and game controllers”.

4. Highlight “Wave sound driver for the Total Recorder”.

5. Click on “Remove”.

6. Close all applications and reboot your computer.

7. Verify that your preferred playback and recording devices are set correctly. You 
can use the Windows system dialog (“Start”, “Settings”, “Control Panel”, 
“Multimedia” or “Sounds and Multimedia”, “Audio tab”), or use the Total 
Recorder menu items (“Options”, “System settings”), and select the devices that 
were set before the installation of Total Recorder. 

Take the following steps for Windows NT:

1. Select "Start"-"Settings"-"Control Panel".

2. Click on "Multimedia".

3. Select the "Devices" tab.

4. Select "Audio Devices".

5. Highlight "Audio for Wave sound driver for the Total Recorder".

6. Click on "Remove".

7. Close all applications and reboot your computer.

8. Verify that your preferred playback and recording devices are set correctly. You 
can use the Windows system dialog ("Start", "Settings", "Control Panel", 
"Multimedia", "Audio" tab), or use the Total Recorder menu items ("Options", 
"System settings"), and select the devices that were set before the installation of 
Total Recorder.

Take the following steps for Windows 2000:

1. Select "Start"-"Settings"-"Control Panel".

2. Click on "Add/Remove Hardware".

3. Click "Next" to continue.

4. Select "Uninstall/Unplug a device" and click "Next".
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5. Select "Uninstall a device" and click "Next".

6. Select "Wave sound driver for the Total Recorder" and click "Next".

7. Select "Yes, I want to uninstall this device" and click "Next".

8. Click "Finish".

9. Close all applications and reboot your computer.

10. Verify that your preferred playback and recording devices are set correctly. You 
can use the Windows system dialog ("Start", "Settings", "Control Panel", "Sounds 
and Multimedia", "Audio" tab), or use the Total Recorder menu items ("Options", 
"System settings"), and select the devices that were set before the installation of 
Total Recorder.

Configuring Total Recorder

The configuration program allows you to set the following:

 suppression of system sounds

 preferred playback and recording devices

 priority of Total Recorder program

 directory for temporary files

 default directory

 actions when a recording is about to be overwritten

 resampling algorithm

 external programs for MP3 encoding

 default format (RIFF-WAVE or MP3) and ID3 tag for MP3 files

 debug mode for driver.

To configure Total Recorder, start the program and select “Options” – “Settings”. You
are presented with a property sheet with the tabs: "System", "Open/save", 
"Algorithm", "MP3 encoding" and "Debug".
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Using the System Tab

The dialog looks like this:

Each of the configuration options is described below.

System sounds 

To prevent system sounds from interrupting your recording, check “Turn off sounds 
assigned to system events”. This is the default and the recommended setting. Your 
system sounds will return when you close Total Recorder.

Audio playback and recording devices

These devices are the names of the real drivers used for playback and recording. This 
is where Total Recorder redirects its input and output sound streams. The installation 
program automatically sets these values according to your current system settings and 
usually you do not need to change them.
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Preferred audio devices when Total Recorder isn't active

This identifies the use of the Total Recorder driver. You can choose from the 
following:

Total Recorder driver (recommended) - does not change the preferred devices 
for playback and recording. The Total Recorder installation program sets the 
Total Recorder driver as the preferred device  (i.e. "Playback through 
TotalRecorder" and "Record through TotalRecorder"). This driver works all the 
time and passes sound through it regardless of Total Recorder being active. This 
is normally transparent to the user. 

Audio playback and recording devices selected above – this is recommended if
the Total Recorder driver conflicts with some other programs and the conflict 
cannot be resolved by reconfiguring those programs. For more information, refer 
to the "Troubleshooting" section of this document. In this mode, Total Recorder 
sets its driver as a preferred device when it starts and your specified real drivers 
(not Auto Select) when you exit.

In this mode, Total Recorder cannot record sound that starts before it was started. 
You must start Total Recorder before your playback program.

Use preferred devices only  - this flag should only be used if you have selected 
“Audio playback and recording devices selected above”. Select the value that will
be set when Total Recorder exits. It is always on when Total Recorder is active. 

High priority

Selecting this option raises the priority of the Total Recorder program. Because sound 
recording is a real-time process, any interruption can lead to skips, clicks, gaps, etc. 
This setting helps eliminate these problems and provides cleaner recordings. 
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Using the Open/Save Tab

The dialog looks like this:

Each of the configuration options is described below.

Folder for the temporary files

The size of recording files can be quite large. Because of this, Total Recorder saves 
recorded information, not in memory, but in a temporary file. You can specify the 
directory for this file, if you wish.

When you first start the Total Recorder program, it sets the directory for temporary 
files based on the following:

 If the system environment variable TMP exists, it uses its value.

 Else, if the TEMP system environment variable exists, it uses its value.

 Otherwise, it uses the directory where the program is installed. 

It is recommended that you store temporary files on the same hard drive where you 
will save your recordings. Otherwise, a full copy operation will be required and this 
will be time consuming for large files.
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Default Open/SaveAs folder 

When you first start Total Recorder, the default directory for opening and saving files 
is the directory from which the Total Recorder program was started. Subsequently, 
Total Recorder can use the previously used directory as the default (select “Last used 
folder”) or you can specify the default directory yourself (select “This folder” and 
specify the location). 

Action on new recording over the previous one
You can select one of the following options during the attempt to record over an 
existing recording:

Delete the old one without confirmation – Clicking the “Record” button 
overwrites (and irreversibly destroys) the previous recording unless it has not yet 
been saved (in full) to a file

Delete the old one with confirmation, if not saved – similar to the above but if
the recording has not been saved (in full) at least once, you must confirm the 
action. Recording does not start until you respond.

Append – a new recording is appended to an existing one regardless of it being 
saved. If you want to create a new file in this mode, you must explicitly select 
“New” from the “File” menu. Sound parameters (i.e. sample rate, mono/stereo, 
8bit/16bit) are always inherited from the recording. Even if different parameters 
are set in “Recording source and parameters” dialog they will not be in effect 
unless you start a new recording.  

A recording is not considered saved unless it was saved in full; partial recordings are 
not considered saved files.
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Using the Algorithm Tab

This dialog lets you set the frequency conversion algorithm and looks like this:

Frequency conversion algorithm

Select one of the following:

Use Total Recorder algorithm – use Total Recorder’s internal algorithm. This is
the default and recommended value. It provides a reasonable compromise 
between speed and quality.

Use system codec – in most cases, this is Microsoft PCM Converter. It is very 
fast but the quality may be unacceptable.
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Using the MP3 encoding Tab

Use this tab if you plan to use Total Recorder with MP3 format. Before working with 
this dialog, you should review the “Working with MP3 Format” section later in this 
document.

The dialog looks like this:

Each of the configuration options is described below.

Select program for encoding to MP3

You can select from the following:

Unable to encode Mpeg Layer 3 – this item is the first in the list if there is no 
MP3 codec installed on your system. If you select this item, Total Recorder will 
not be able to create MP3 files and “MPEG Layer 3: press F1 to get help” appears
in the list of sound formats. You can use F1 to display some links to find MP3 
encoders.

[Windows system codec] – this item is the first in the list if there is at least one 
MP3 codec on your system. If you select this item, Total Recorder will rely on 
the system to select an appropriate codec. 
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(Name of a particular codec) – one of these entries appears for each MP3 codec 
in the system. You can select any codec from the list. Normally there is only one 
MP3 codec installed, in which case you can either select it here or select 
[Windows system codec] as above.

Blade encoder (dll) – use BladeEnc.dll to encode to MP3. Total Recorder will 
show this item regardless of whether this dll exists on your system. However, you
can only save this setting if you provide a full path to BladeEnc.dll in the 
Location field. 

Lame encoder (dll) –use Lame_Enc.dll to encode to MP3. Total Recorder will 
show this item regardless of whether this dll exists on your system. However, you
can only save this setting if you provide a full path to Lame_Enc.dll in the 
Location field.

Location

This identifies the full path for the external encoding program. Total Recorder will 
locate the program itself if it is in one of the PATH directories. Otherwise, click 
Change and enter the location. For example:

Version

Total Recorder checks the version of the external program. Some older versions are 
not supported, in which case an error message appears and you will need to download 
a newer version. 

For stereo mode

MP3 format supports different versions of encoding stereo audio signals. When Total 
Recorder displays a dialog for selecting a format, it only includes mono or stereo. If 
stereo is specified, it will be encoded according to the mode selected in this tab.

You can select from the following, although some modes may not be available for 
some encoding programs:

Stereo – each channel is encoded separately but not necessarily the equal amount 
of space is allocated for each channel. For example, the encoding program may 
allocate a larger part to one channel based on the actual content of the sound 
stream.
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Joint stereo – both channels are encoded together. The average of the two 
channels is calculated and encoded. The difference between channels is also 
encoded but with a lower bit rate. This method saves some space but the quality 
may suffer. This mode is not recommended for high-quality recordings with high 
bit rates (i.e. more than 192 Kbit/sec.).

Dual channel – each channel is encoded separately and independently. This is 
recommended where the content is not actually a stereo recording but two 
independent sound streams.

Quality

You can select the desired quality if the encoding program allows it. The better the 
quality you select, the slower the encoding will be.

File type

You can select the desired header format for MP3 files – either RIFF-WAV (WAV-
MP3) or “pure” MP3. Click the Change button to change this setting. You can 
override this default value when you save a recording but it requires a full copy of the 
file.

ID3 tag

You can add an ID3 tag to pure MP3 files but not to RIFF-WAV files. This tag can 
contain such information as the artist name, the album, etc. You can click on the 
Change button to set a default. For more information, refer to the "Using the MP3 
properties dialog" section later in this document.

You can override this default value when you save a recording. It is fast and does not 
require a full copy.

Note: Only version 1 of the ID3 tag is currently supported.
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Using the Debug Tab

The dialog looks like this:

Driver debugging

Use this option only when advised by Technical Support. Selecting this option will 
result in additional overhead on your system.

Registering Total Recorder

After installing and verifying the program works properly, you should obtain a 
registration key from High Criteria. If the program is unregistered then your 
recordings are limited to 40 seconds each and you can use the scheduler only as an 
alarm.

Note: You cannot use your Version 1.x or 2.x registration key with Version 3.0. 
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To receive the registration key:

1. For registered users of versions 1.0 or 2.x. All registered users are entitled to a 
free registration key. It is sent by E-mail automatically unless you specified that 
you do not want to receive E-mails from High Criteria or you have not provided 
your E-mail address. If you are a registered user, want to upgrade, and didn’t get 
your registration key for some reason, contact support@HighCriteria.com

 OR

For new users: Follow the instructions given on High Criteria Inc.'s web site at 
the following address: http://www.highcriteria.com/products.htm.

2. Select “Help” - “Registration”. Type in the same name you used to obtain the 
registration key and your registration key. Note that after registration this menu 
item is not accessible.

To order by check refer to the Registration.txt file in the installation folder of Total 
Recorder.

Uninstalling Total Recorder

To uninstall Total Recorder, use “Start”, “Settings”, “Control Panel”, “Add/Remove 
Programs”. The Total Recorder driver remains in memory until you reboot.
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USING TOTAL RECORDER
Total Recorder works as a standard Windows multimedia program. You can use 
standard buttons, menu options, and keyboard shortcuts for recording and playback. 

Setting Recording Parameters

Before you begin recording, use the “Recording source and parameters” dialog to set 
your recording parameters. These parameters are saved for subsequent use. Changing 
parameters after a recording is finished affects only subsequent recordings; Total 
Recorder can convert already recorded sound during saving only.

When you schedule recordings using Total Recorder's built in scheduler, you can use 
different parameters for each job using the “Schedule Item” dialog.

Click on the “Recording source and parameters” button or select “Recording source 
and parameters” from the “Options” menu. You are presented with the following 
dialog:
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Recording source

Select one of the following (mutually exclusive) sound sources:

 Software – capture and record sound played back or requested by other computer 
programs. This feature is unique to Total Recorder and is not available from the 
vast majority of other sound recording programs.

 Sound board – record sound digitized by a sound card. This includes a 
microphone, CD or other input lines.

Additional parameters for source “Software”

If you select “Software”, you can specify the following:

 Convert using parameters specified below – convert the recorded sound to a 
format specified in the "Recording parameters" area. 

If this is not selected, the recorded sound will be in the original format. If different
parts of the sound have different formats then only the longest part will be 
recorded.

 Record also input stream (Internet telephony only) – capture and record input 
sound streams, requested by programs from the soundboard. This applies only to 
the recording of Internet telephony conversations.

 Make Stereo – special mode for Internet-telephony only. You can set this 
option only if you have set the “Record also input stream” flag above. This 
creates a stereo file where one voice is in one channel and the other voice is in 
another channel. 

If “Make Stereo” is not set, the voices of both speakers will be mixed in one 
channel.

 Accelerate recording (silent mode) - the Total Recorder driver makes the 
playback program generate sound with a faster speed and suppresses the actual 
sound. Not all playback programs are compatible with this mode. For more 
information, refer to the "Accelerated Recording" section, described later in this 
document. If you select this option you must use the “Speed” pull-down menu to 
select the desired speed. 

 Speed: Max. – Total Recorder tries to make the playback program play at 
maximum speed. This is recommended for converting a sound file from a non-
standard format to a standard format.
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 Speed: a value – set at a particular speed. Total Recorder tries to make the 
playback program play a specified number of times faster than normal. For 
example, you can set this speed to "4" to cause the playback program to play 4 
times as fast as normal. This setting is recommended if the maximum speed is 
not possible (e.g. when recording from the Internet).

Additional parameters for source “Sound board”

If you select “Sound board”, you can specify the following:

 Use current mixer settings – use current system settings. Normally, they can be 
viewed or changed from the standard mixer by double clicking on the “Volume 
Control” icon in the system tray.

 Use these lines of … (the full name of this flag depends on the sound driver of the
sound board) – points explicitly to lines that are switched on during recording. At 
least one line has to be specified. After a recording is finished, the original mixer 
settings are restored.

Using Different Settings
The following explains some different settings: 

 If you select "Software" as the Recording source and PCM is specified, the 
conversion algorithm depends on the value selected under the Algorithm Tab. See 
the "Using the Algorithm Tab" section earlier in this document.

 If you select "Software" as the Recording source and a compressed format is 
specified (non-PCM), the compression will be performed either with a selected 
codec or (for MP3 only) with an external program. See the "Using the MP3 
encoding Tab" section earlier in this document.

 If you select "Sound board" as the Recording source and PCM is specified, no 
conversion is needed. Sound board will produce the required format.

 If you select "Sound board" as the Recording source and a compressed format is 
specified (non-PCM), the closest PCM format will be requested from a sound 
board and compressed. 

Any necessary conversions are normally done on the fly (i.e. as the recording is being 
made). If a conversion requires too much time and cannot complete during the 
recording, it will continue after the recording is finished. Refer to the "Long 
Operations" section later in this document.

Recording parameters

This sets recording parameters. To change a format click on the "Change" button. The
“Sound format selection” dialog appears.
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Using the Sound format selection Dialog

The dialog looks like this:

Each of the fields is described below.

Name – list of named formats. You can select any format from the list. There are 
some system-named formats and you can name any format and save it for future use. 

Save As – assign a name to the format and its attributes so it will appear in the 
“Name” list above.

Remove – remove a named format. Note that you cannot delete a system-named 
format.

Format – list of format types. Note: To record in MP3 format you must have a fully 
functional codec (i.e. one that can encode and decode) or a special program. For more 
information, refer to the "Working with MP3 format" and "Using the MP3 encoding 
Tab" sections.

Attributes – list of format parameters.
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The Total Recorder Dialog

The Total Recorder dialog is made up of different parts, as shown below:

Properties 

This part of the dialog displays information about the current file being played or 
recorded. For example:

Mpeg Layer 3 Blade – format name. For MP3 (Mpeg Layer 3) the name of the 
encoder may be appended (e.g. Blade).

32kbit/s; 44,100Hz; Stereo – format parameters.

The line below these format parameters is normally empty but may contain a 
message such as "xx.x sec. of other formats lost". This message appears only in 
Software mode and only when the output format is not specified. If this is the 
case, and the recorded sound contains several fragments with different 
characteristics, only the longest fragment is kept and all others are lost.

Data size (bytes) – size of recorded data in the recording/playing file. This does 
not include the length of the non-data part. You can display the full length by 
selecting “File", "Properties".

Length (sec.) - playback time in seconds.

In xx%, Out xx%, Both xx%, Fail xx% - this information appears only when 
you record. The display varies depending on the recording activity.
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Recording Activity Display
Sound being played back Out 100%
Internet telephone conversation in
full-duplex mode

Both 100%, since sound is transmitted back 
and forth simultaneously

Internet telephone conversation in
half-duplex mode

In - % of time the user of the given 
computer talked
Out - % of time the remote partner talked

From microphone, CD or other 
input line

In 100%

Internet telephone conversation in
full-duplex mode, different 
format for input and output 
sounds 

Fail 100%

Note: When you are appending to an existing file, this data relates only to the 
appended fragment and not to the entire file.

Status  

This part of the dialog displays the current status of Total Recorder. The possible 
values are: “Playing”, “Paused Playing”, “Recording”, “Paused Recording”, “Auto 
playing until hh:mm:ss”, and “Auto recording until hh:mm:ss”. Some further 
explanations follow.

“Auto” - recording or playback was started by the scheduler or from the command 
line, or auto stop is on. The time (hh:mm:ss) is the time that the job will complete. 
You cannot control the job other than cancel it by clicking on the “Interrupt work” 
button on the main program window or selecting “Interrupt work” from the 
“Play/Record” menu. Other controls, such as “Pause” are disabled. You can cancel 
Auto stop by selecting "Play/Record", "Auto stop recording".

Clock icon - indicates that a scheduled job is currently in progress, or Auto Stop is 
on. It does not relate to the fact that some jobs are scheduled. 

Level indicator - reflects the amplitude of a signal during recording and playback.  
When recording from “Software” the “reactivity” depends on the size of the playback 
program's internal buffer. For some programs this can be changed once per second or 
even more often. 

“Interrupt work” button

This button allows you to cancel a scheduled job that is in progress, or auto stop. 
Already recorded information is put to a file and an error message “Job interrupted by 
user” is written to the Total Recorder Log.  
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“Recording source and parameters” button

This button displays a dialog for the recording source and parameters. For more 
information on this dialog, refer to the section “Setting Recording Parameters” earlier 
in this document.

This dialog is disabled during recording since you must set recording parameters in 
advance.

Slider 

In playing mode, the slider reflects which part of the sound file has been played back. 
You can move the slider backwards or forwards.

In recording mode, the slider is initially at the leftmost position. It moves immediately
to the rightmost position once real recording starts.

Position (sec.)

This part of the dialog displays the real recording time (in seconds) when Total 
Recorder is in recording mode, or the reproducing time (in seconds) when Total 
Recorder is in playing mode.

Markers

Markers - ,  - let you select and save a fragment of a recording, or other sound file, 
to a file. The current position of each marker is controlled by a separate group of 
buttons. You can position markers with 0.1-second accuracy.

Markers below the slider are not visible by default. Select "View", "Show selection" 
from the menu to see them. 
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Here is the main dialog with markers displayed:

The following are some characteristics of markers:

 The buttons that control each marker show the position in seconds.

 If the left marker ( ) moves to the right of the right marker ( ), they automatically 
switch positions.

 Initially the right marker ( ) points to the end of the recording (file).

Marker Control Buttons

The control buttons for each marker are:

Button Description

Mark Mark the current position of the main slider. The marker 
moves; the main slider’s position does not change.

Go Go to the marker. The main slider moves; the marker’s 
position does not change.

Precise marker positioning. The marker moves 0.1 second 
left and right. The main slider’s position does not change.
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General Marker Control Buttons

The general control buttons for markers are:

Button Description

UnDo Undo the previous marker move. It does not affect the main 
slider. Up to 1000 operations can be undone.

ReDo Redo move.

Save As... Save the part of the recording between the markers. 

Auto Stop flag

If set, the “Auto Stop” flag causes the playback to stop at the right marker. This 
ensures the selection ends at the correct place.  

Buttons

You can use the following buttons:

Button Description
Rewind to the beginning

Left (one step)

Right (one step)

Play 

Pause/continue

Stop

Record

Between the " " and " " buttons is a list for selecting the step these buttons use to 
position your recording. The step is specified in units of time, ranging from 1/10 of a 
second (0.1s) to 15 minutes (15m).
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Recording

In order to record all of the sound generated from a software program, you should 
start the recording before starting the playback's program. Every playback program 
sends information to a driver with some delay, usually several seconds. If you start 
recording when sound has already played back, it will look as if nothing happens for 
several seconds and then the indicators will show the real beginning of the recording.

For information on using the built-in scheduler or command line to schedule a 
recording, refer to the section “Using a Scheduler” later in this document.

For information on recording using "Software accelerated recording/converting", refer
to the section "Accelerated Recording" later in this document. 

Starting Recording

Before you begin recording, set your recording source and other parameters if these 
have not been set as you require. Click on the “Recording source and parameters” 
button or select “Recording source and parameters” from the “Options” menu. Refer 
to  “Setting Recording Parameters” earlier in this document for more information. 

To start recording, either click on the “Record” button ( ), select Record from the 
“Play/Record” menu, or press Ctrl-R. 

As soon as your recording starts, the message “You have unsaved data!” appears 
under the “Record” button. This is to remind you that data is being written to a 
temporary file. If you want to store the output permanently, you must save the data 
once your recording is complete. 

If you try to make a new recording before saving the previous one, the result depends 
on the setting "Action on new recording over the previous one". For more 
information, refer to the "Using the Open/Save Tab" described earlier in this 
document.

If "Software" is selected as a source, a sound is recorded only when some program 
reproduces or requests it. After starting the “Record” feature, the corresponding 
indicator on the “Status” panel becomes highlighted. This indicates Total Recorder is 
ready to record but the real recording process does not start until Total Recorder 
receives some sound from another program. If the level indicator does not become 
green, there is no data to record.

Interrupting a Recording

To temporarily interrupt recording, either use the “Pause/Continue” button ( ), 
select “Pause” from the “Play/Record” menu, or use Ctrl-U. To continue a paused 
recording, either use the “Pause/Continue” button again, select “Continue” from the 
“Play/Record” menu, or use Ctrl-U.
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If "Software" is selected as a source, all information during a pause will be written to 
a temporary file. This allows a recording to continue immediately after the pause is 
finished. Remaining in “pause” for a long time may take a lot of your hard disk space 
and is therefore not recommended.

Stopping a Recording

To stop recording, either use the “Stop” button ( ), select “Stop” from the 
“Play/Record” menu, or use Ctrl-P. 

Saving a Recording

To save a recorded sound stream to a file, use “Save” or “Save As” on the “File” 
menu, or press Ctrl-S. The file is saved as a .wav or a .mp3 file.

A recording is not considered saved unless it was saved in full. This affects the actions
taken when you are about to overwrite a recording.

Saving Part of a Recording

You can also select and save only part of a recording by taking the following steps:

1. Make the markers visible, if they are not visible already, by selecting "View", 
"Show selection" from the menu.

2. Select the left and right boundaries by moving the slider and placing markers. For 
more information, refer to the "Markers" section described earlier in this 
document. You can set markers during recording and then slightly reposition 
them.

3. Save your selection. Use the "Save as..." button in the Markers group or select 
"File", "Save selection as" from the menu.

Saving Multiple Recording Fragments
You can save multiple recording fragments as different files. The size of a .wav file 
cannot exceed 4GB. This is an internal limitation of the WAVE format. If the size of 
your recording is greater than 4GB, you can either divide it into smaller parts or 
convert it to a lower quality. 

Saving a Recording in a Different Format
You can save your recording in a format different from the original, however it may 
take a significant amount of time. 
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To change the format, take the following steps:

1. Choose the “Save As” dialog.

2. Click on “Change” and select a format. For more information, refer to the “Using 
the Sound format selection Dialog” section earlier in this document.

3. If you select MP3 format, you can click "More" and change the default file type 
and ID3 tag. For more information, see the "Using the MP3 properties Dialog" 
section later in this document. Changing a file type requires a full file copy but 
deleting, adding or editing the ID3 tag does not.

4. Enter the name of the new file, if you haven't already done so. The default 
extension is .wav or .mp3 depending on the selected format. You cannot manually 
specify an extension.

5. Click “Save” to save your recording.

Using Fast Save

Beginning with Version 3.0, Total Recorder writes a ready-to-use wav or mp3 file 
without saving an intermediate working file. A save operation usually just renames 
(moves) the working file and is almost instantaneous regardless of the file size. 
However, the following situations will prevent this and require copying of the entire 
file.

 The file is being saved to a different drive, either physical or logical, than the 
drive that stores the working file. Use "Options", "Settings", "Open/save" tab to 
change the location of the working file.
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 The file format changes.

 The header type changes from RIFF-WAV to MP3 or vice versa.

 The file is being normalized.

 The existing file was appended with new data.

Note that changing the ID3 tag does not prevent a fast save operation.

Using Auto Stop Mode
When Total Recorder is recording, you can specify a date and time when the 
recording will stop. You can set or reset the auto stop mode by selecting "Auto stop 
recording" from the "Play/Record" menu. The following dialog appears:

Stop recording at – when this box is checked, auto stop is on. You can then use the 
fields to the right to specify a date and a time:

Date (year, month, day), time (hours, minutes, seconds) – set the date and time 
to stop the recording. 

Now – display the current date and time. This is useful when you want to use a 
relative time such as 5 minutes from now.

Save recording to the file – the file name where the recording will be saved. This 
field is mandatory.

Normalize to – check this box to normalize before saving then use the box to the right
to specify a percentage. This is enabled only for PCM format. For more information, 
see “Normalizing a Sound File” later in this document.
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Quit Total Recorder after job completed – Total Recorder will close after the 
recording stops.

When auto stop is active, all other controls are disabled. The behavior is similar to 
that of a scheduled job (see "Actions you can take during a Scheduled Job"). The only 
difference is that you can cancel the auto stop by selecting "Play/Record", "Auto stop 
recording" again and the recording will continue in regular mode. Any error messages 
are not displayed but are written to the Total Recorder Log (see "Handling Errors and 
Other Problems"). 

Accelerated Recording 

Software accelerated recording (silent mode) lets you convert sound files of different 
formats to standard wave format. This is normally done at a fraction of the time 
required to play the file. Total Recorder suppresses playback, makes the sound stream 
go through the driver with an above normal speed, and records it.

The playback program switches to a different mode only when the new sound stream 
starts. When using accelerated mode you must switch on record first and then start 
playing the sound back.

When using accelerated mode you cannot hear any sound but the slider of the 
playback program moves faster than normal. Total Recorder also shows the recording 
moves by the following:

 the indicator of the current position moves faster than normal 

 the level indicator changes from being empty to green.

Compatibility    

Since the playback program has to work faster than was intended, some programs are 
not compatible with this mode. They will either work with normal speed or some error
may occur (e.g. some fragments may be lost or repeated more than once, or some 
extra pauses or noises may be inserted). Different versions of the same program may 
behave differently. 

This document does not provide a list of compatible and incompatible programs. The 
simpler the playback program the more likely it will work correctly in accelerated 
mode. Programs that synchronize sound with some other events such as games or 
video players will not likely work in accelerated mode.

The maximum possible speed may also vary. This usually depends on some internal 
parameters of a playback program, which are not documented and are not 
configurable, because normally they do not matter.  
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Through experimentation, you can determine both the compatibility of a particular 
program with accelerated mode and the optimal speed. Make your recording then 
listen to it. If there is no problem, or a problem that can be easily corrected with a 
selective save, you may use the accelerated mode. Otherwise, you can lower the 
speed. If this doesn't help you can either use regular recording or change your 
playback program. 

If a program plays a sound from a hard disk or a local area network and it allows 
accelerated mode, it will probably allow maximum speed. However, there are some 
exceptions. If the program plays a sound from the Internet, it is usually impossible 
because the sound driver will request the information faster than the connection 
supplies. In this case, you can manually adjust the speed based on the available 
bandwidth. If the connection is either very slow or bad, try to set the speed below 
normal. 

Playing a Sound File

To play a sound file, either click on the “Play” button ( ), select “Play” from the 
“Play/Record” menu, or press Ctrl-Y. Total Recorder starts to play the recording from
the current position or from the beginning if the current position is set to the end of 
the file.

For information on using the built-in scheduler or command line to schedule a 
playback, refer to the section “Using a Scheduler” later in this document.

Pausing the Playback

To interrupt the playing of a sound file, either click on the “Pause/Continue” button (
), select “Pause” from the “Play/Record” menu, or press Ctrl-U. To resume a 

paused playing, either click on the “Pause/Continue” button, select “Continue” from 
the “Play/Record” menu, or press Ctrl-U.

Moving Within a File

You can use the slider to move forward or backward in a sound file or you can use the
rewind button (  ) to go to the beginning. Additionally, you can move right or left 
with a fixed step using the  and  buttons or their keyboard equivalents (Ctrl-L - 
left, Ctrl-T - right). There is a drop-down list for selecting the step between the   
and buttons.

Stopping

To stop playing, either use the “Stop” button ( ), select “Stop” from the 
“Play/Record” menu, or use Ctrl-P.
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Playing a Selection

If markers are visible in the main window, you can play a selection by selecting “Play 
selection” from the “Play/Record” menu or by using Ctrl-E.

Normalizing a Sound File

Normalizing is a process of increasing the sound level (loudness) so that the amplitude
of the loudest parts is close to the maximum allowed for a given sound format. 
Because it also increases the level of noise, normalizing should only be used if there is
no other way to adjust the volume. For example, you should not use normalizing with 
Sound Board mode recording because you can always adjust the level using a mixer.

Only a non-compressed file (PCM format) can be normalized. 

To normalize a sound file, take the following steps:

1. Select “Volume”, “Normalize” from the main menu. The  “Normalization” dialog 
appears, as shown below.

2. Select the level of normalization in percentage. The default is 100%. If you plan to
later transform your sound file (to compress it, for example), it is recommended 
you set this value to 80-90% to avoid overflowing. 

3. Click on “OK”.

The normalization process is fully reversible. You can set any value and go back to 
the original.

In rare cases, you may need to set the normalization percentage greater than 100. For 
example, you can improve a recording if the average level is low but there are a 
couple of peaks (may even be noise).

Long Operations

The following operations may take a significant amount of time:

Total Recorder Page 43



 Saving a file, if fast saving is not possible.

 Finishing "on the fly" conversion, if it was not possible in real time.

 Calculating the maximum amplitude for normalization.

The following dialog appears during long operations: 

Stopping a Long Operation

To stop an operation, click “Cancel” and reply to the confirmation. The result depends
on the operation:

 Saving a file – stops and erases the part of the file that has already been written.

 Converting format – stops and the converted part of the file is saved.

 Normalization – the Normalization dialog will not be displayed.

Working with MP3 Format

Total Recorder does not have a built-in compression/decompression engine for any 
sound format, including MP3. Total Recorder can only play and record a compressed 
file if the appropriate audio codecs are installed.

Using Codecs

An audio codec is a special program (driver) that converts sound formats. When a 
codec is registered (installed) it can be used by any audio processing application. Each
version of Windows includes a basic set of codecs. Users can also download, or buy 
and install, additional codecs. Starting with version 3.0, Total Recorder can use 
codecs installed in your system.
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There are different types of codecs that support MP3. A simple codec can only decode
MP3 and is sufficient for playing MP3 files. However, to create an MP3 file you need 
a codec that supports encoding. A codec that only supports encoding for low bit rates 
is included in some versions of Windows (e.g. Windows 98 and Windows ME). This 
is sufficient for recording radio broadcasts but not for CD-quality music. You can buy
codecs that support higher bit rates.

Using DLLs

Total Recorder can also use a dll (dynamic link library) dedicated to MP3, either 
BladeEnc.dll or Lame_Enc.dll. Unlike codecs, neither one of these dlls can decode an 
MP3 file, which means that Total Recorder may be able to record but not play MP3 
files. If you use one of these dlls, it is recommended that you also install a decoding-
only codec to enable both playing and recording of MP3 files.

Selecting an MP3 Encoder

MP3 encoders, including codecs, BladeEnc.dll, and Lame_Enc.dll, differ in price, 
speed and quality. Select the one you find most suitable.

Types of MP3 Format

Total Recorder can play and record MP3 files in either WAV or MP3 format. The 
difference is in the file header.

WAV-format files have a standard RIFF-WAVE header. These files usually have 
a .wav extension. As long as an appropriate codec is installed and recognized, any 
playback program can play them.

Pure MP3-format files do not contain any special headers but may contain an ID3 tag. 
These files usually have a .mp3 extension. To play this type of file, you need a 
program that can decode MP3 format.

Setting MP3 Parameters

You set parameters relating to MP3 on the "MP3 encoding" tab of the configuration 
dialog. For more information, see "Using the MP3 encoding Tab" earlier in this 
document.

Using the MP3 properties Dialog
Total Recorder lets you record MP3 files as WAV-MP3 files, with a standard RIFF-
WAVE header, or "pure" MP3 files. For pure MP3 files, you can also create an ID3 
tag that contains information about the song.
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You can invoke this dialog from different places. If you invoke it from the 
configuration dialog or saving dialog, you can change the File header type. If you 
invoke it from the "ID3 tag" field of the “File” menu, only part of this dialog appears. 

The "ID3 tag" menu item is enabled for "pure" MP3 files only.

Note: Only version 1 of the ID3 tag is currently supported.

Displaying File and Recording Properties

You can display properties of a file and of a recording by selecting “File”, 
“Properties”. The following dialog appears:
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Columns

There are the following two columns, or groups, in the display: 

File – this left column relates to a disk file (i.e. the last saved version). If the 
recording was not saved and was not appended to an existing file, this column will be 
empty.

Recording – this right column relates to the current recording, which has not yet been
saved. This column becomes empty once the recording is saved.

Rows

The rows of each column are described below.

Type – header type.

RIFF-WAVE – standard header. This type of file normally has a WAV extension.

MP3 – no header. This applies only for MPEG Layer 3 (MP3) files. This type of file 
normally has an MP3 extension.

Format – format description. The first line indicates the format type: PCM – main, 
non-compressed format; all other formats are compressed. The second line indicates 
the frequency, number of channels (mono or stereo), and some format–dependent 
parameters (e.g. bit rate for MP3).

Date, time – date and time of the last modification.

File size – full size of file.

Data size – size of data in the file. This excludes headers and tags.

Play time – play time. This is an approximate time only and the accuracy depends on 
the compression and the particular codec. 
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Using a Scheduler

Total Recorder lets you program jobs (recording or playback) to start at a given time, 
similar to programming your VCR. You can either use Total Recorder's built-in 
scheduler or use command line options with an external scheduler, such as Microsoft 
Task Scheduler. The preferred method is to use the built-in scheduler because it lets 
you set all the parameters using a GUI and you can set different parameters for each 
job.

To start the built-in scheduler:

Select “Schedule…” from the “Options” menu. You are presented with the 
“Record/Play Schedule” dialog box.

To use an external scheduler:

Put Total Recorder as one of the scheduled tasks using the appropriate command 
line parameters. These command line parameters are described later in the section
“Using the Command Line”.

The Total Recorder Log contains a list of all messages relating to jobs scheduled by 
the built-in scheduler or initiated through the command line. For information on this 
log, refer to the section “Using the Total Recorder Log” later in this document.

Launching Scheduled Jobs

Launching of a scheduled job starts one second before the scheduled time. The actual 
starting time depends on the speed of your computer but one second is usually more 
than enough to start a program. A scheduled job stops at exactly the scheduled time 
regardless of the time it was started.

For each scheduled job, a new copy of Total Recorder is launched regardless of 
another copy being present. This copy closes after the job is finished except in the 
following two cases:

 you started the job with command line parameters (either explicitly or implicitly) 
that indicate the copy should stay active

 you interrupted the job.

Actions You Can Take During a Scheduled Job

During performing a scheduled job or a job initiated from the command line, all 
buttons and menu items are disabled except:

 the “Interrupt work” button 
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 the “Interrupt work” item of the “Play/Record” menu 

 the item “Exit” of the “File” menu. 

Clicking the “Interrupt work” button or selecting the corresponding menu item stops 
the job. Already recorded information is put to a file, an error message “Job 
interrupted by user” is written to the Total Recorder Log, and Total Recorder stays 
active. When you use “Exit” from the “File” menu or close Total Recorder in any 
other way (e.g. Alt-F4), all of these actions are done after the program terminates.

Handling Errors and Other Problems

The Total Recorder sound driver is a component that checks the time and launches the
Total Recorder program. If for some reason the driver is not installed, scheduled jobs 
will not be launched.

Error messages, such as “file does not exist”, do not go directly to a user since a user 
is not always present. These messages go to the Total Recorder Log.

If recording was active but nothing was actually recorded, the empty file is not saved 
and a message “Nothing was recorded” is written to the Total Recorder Log. This may
happen if  “Software” was set as a source but none of the programs played sound 
during the recording time. The job is considered to perform normally if it was not 
interrupted.

Displaying and Controlling Scheduled Jobs

The “Record/Play Schedule” dialog shows a list of scheduled jobs. From this dialog 
you can control scheduled jobs and create new ones.
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Select “Schedule” from the “Options” menu and you are presented with the following 
dialog:

Job – scheduled job types, “Play” or “Record”. There is an icon to the left that 
reflects the job status:

Icon Status
job should be performed
job is disabled

No icon job should not be performed because the time 
has passed, regardless of whether the job was 
actually performed

Status – the result of the job. For a repeated job (e.g. daily), the last result is 
displayed. You can view detailed results in the “Schedule item” window, accessed 
with the “Edit” button. This window is described later.

The Status field may be one of the following:

Status Explanation
Empty never run
Done job ran normally
Expired job did not run and never will because the time has 

already passed. Your computer being switched off at the
scheduled time for the job may have caused this. For 
repeated jobs, this will never be displayed. 

Interrupted job was interrupted by a user
Error error during the job. The error message can be viewed 

in the “Schedule item” window.
Running Currently the job has been performed by another 

running instance of Total Recorder. It is also possible 
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Status Explanation
that the job was started but there is no information of a 
normal or abnormal termination. Your computer being 
switched off during the job may have caused this.

The Status field contains information from the Total Recorder Log. If records 
were deleted from the Total Recorder Log, either automatically or manually, they 
will not appear here. If all records for a particular job were deleted, the job will 
appear as if it had never run.

Date – identifies when the job should run:

Date Explanation
Daily each day
Day of the week each week on the given day 
YYYY.MM.DD the date when the job should run 

Start time – the time the job should start (in 24-hour format, hh:mm:ss).

Stop time – the time the job should finish (in 24-hour format, hh:mm:ss). If the 
“Stop time” is less than the “Start time”, it is assumed that the “Stop time” belongs
to the next day. For playing a file, you can omit the “Stop time” and the file will 
be played back once.

File – the name of the file being played or recorded. This is always a full path. 
When using automatic file name generation for recording it will show “* Auto *”.

Controls

You can use the following controls from this dialog:

“Delete when done” flag. If set, a job that finishes normally will automatically be
deleted from the list.

“New” button. Open the “Schedule item” dialog for entering a new job.

“Clone” button. Build a new job by copying the current one and then open the  
“Schedule item” dialog for editing. This is useful, for example, if you need to 
schedule a job to run on certain days of the week but not daily.

“Edit” button. Open the “Schedule item” dialog for detailed viewing and editing 
of job parameters.
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“En./Dis.” button. Current job switches between Enable and Disable status. An 
icon reflects the current status. A crossed icon means Disable and such jobs are 
kept in the list but are not started.

“Delete” button. Deletes current job, after confirmation.

“OK” button. Accept all changes.

“Cancel” button. Discard all changes. If any changes were made, confirmation is 
required.

Scheduling a Job

Use the “Schedule Item” dialog to schedule a job, either a recording or a playback.

1. Open the “Record/Play Schedule” dialog.

2. Use the “New” button to create a new job.

OR

Select a job and use the “Clone” button to copy the current job for editing. 
This is useful, for example, if you need to schedule a job to run on certain days
of the week but not daily.
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3. Use the following dialog to specify your requirements:

Job

You must specify the action, either  “Play” or “Record”.

Status

Lists all of the Total Recorder Log messages, in chronological order, for the current 
job. If a job has not started, this field is empty.

The purpose of this field is to help you with scheduling. For example, if you edit an 
old job it can be useful to see if it has ever run and what the results were.  

Date

You can schedule jobs with the following frequency:

Frequency Explanation
Once one time. Specify year, month and day (in 

that order) when the job should start.
Daily each day 
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Frequency Explanation
Weekly each week. Specify (or select from the list) on

which day of the week the job should be 
scheduled. 

The “Now” button sets the current date and time as the moment when the job 
should start. The time when the job should stop is set as the current time plus one 
second. After that, you can modify these parameters manually.

Time

You can specify a starting time and a stopping time:

 Start at –time (hours, minutes, and seconds) when the job should start. The 
job will be launched one second before the scheduled time. 

 Stop at – time (hours, minutes, and seconds) when the job should stop. This 
is required for recording and optional for playback. Zeros in this field means 
midnight and not the absence of a stop time. If the “Stop at” time is less than 
the “Start at” time, the activity (either play or record) will stop the next day. 

If you want to specify a stopping time for playback, click on the “Stop at” 
flag to the left and enter your stop time. Without a stop time, the file will be 
played once. If the flag is on, a file will be played continuously from the 
“Start at” time until the “Stop at” time, regardless of the length of the file.

Recording source and parameters

When you use this button the Recording source and parameters dialog appears. Refer 
to the "Setting Recording Parameters" section.

MP3 file properties

This button is enabled only when you schedule a recording and conversion to MP3 
(MPEG Layer 3). When you click this button, the MP3-file properties dialog appears. 
Refer to the  "Using the MP3 properties Dialog” section earlier in this document.

File

This specifies the name of the file you want to create or play:

Auto create filename (TRyyyymmdd_hhmmss) – this may be used for recording 
only. A new file is created based on the current date and time when the job completes.
The file will be placed in the Total Recorder current directory.
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This name – a file name for recording or playback. You can enter it manually or use 
the “Browse” button.

Normalize to – normalize the recording, using the percentage indicated, before 
saving. This only applies when recording. The Scheduler lets you specify 
normalization for all formats including compressed. It the latter case, the actual 
recording is in PCM format  and will be normalized and converted when saving.

When saving an automatically recorded file, Total Recorder overwrites an existing file
with the same name and no message is written to the Total Recorder Log. If a file 
with a given name cannot be created (e.g. the directory does not exist) a message is 
put to the Total Recorder Log and all recorded information is lost. It is recommended 
you use automatic file name generation to decrease the risk of these errors.

Using the Command Line

Performing a job specified in the command line is similar to performing a job started 
by the built-in scheduler. From the command line, you can play or record a file.

General Command Line Syntax

The syntax of Total Recorder's command line is:

TotalRecorder [Filename] [/Play|/Record] [/Time:[[hh:]mm:]ss] 
[/Normalize[:percent]] [/Noclose]

A file name, if specified, must be the first parameter. Other parameters can be in any 
order.

Filename Parameter

The name of the file you want to load, play or record. If the name contains spaces, 
enclose it within double quotes (e.g. “My Recordings”).

/Play Parameter

Play a file. The filename is mandatory.

You can use the abbreviation - /P.

/Record Parameter

Perform recording. The current source and recording parameters will be used. If a file 
name is specified the result will be saved with this name. Otherwise, a name in the 
form of  TRyyyymmdd_hhmmss.WAV will be generated based on the current date 
and time. The file will be placed in the Total Recorder current directory.
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For recording, duration must be specified using the /Time parameter.

You can use the abbreviation - /R.

/Time Parameter

Specifies the duration of recording or playing. This is required for recording. 

If you omit this parameter for playing, the entire file will be played once. If you 
specify this parameter for playing, a part of a file may be played or the playing may 
be repeated as necessary. For example, if you schedule a 4-minute file to play for 10 
minutes, it will play 2 1/2 times. Or if you schedule a 10-minute file to play for 4 
minutes, only the first 4 minutes of the file will play.

You can use the abbreviation - /T.

There are three different ways to specify duration. The following examples each 
specify the same duration (1 hour, 1 minute, and 1 second):

 /T:hh:mm:ss, for example: /T:1:01:01 or /T:1:1:1

 /T:mm:ss, for example: /T:61:01 or /T:61:1

 /T:ss, for example: /T:3661

The following are not correct:

 Incorrect: /T:1:61:01 - since mm cannot exceed 59

 Incorrect: /T:2:60 - since ss cannot exceed 59

/Normalize Parameter

This parameter causes Total Recorder to normalize the file to a given percentage after 
it is recorded. You can specify a value from 1 to 999. The default is 100%. For 
example: /Normalize:95 .

You can use the abbreviation - /Norm.

/Noclose Parameter

This parameter causes Total Recorder to stay active after the job is done. If not 
specified, Total Recorder will close except in the case where neither /Play nor /Record
were specified.

You can use one of the abbreviations - /NC or /N.
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Examples

Perform recording for five minutes, save the result in a file with an automatically 
generated name and do not close the program: 

TotalRecorder /R /T:5:00 /NC

Play a sound file and close the program:

TotalRecorder C:\MyFolder\MySoundFile.WAV /P

Play a bell (Ring.WAV) continuously for one minute:

TotalRecorder C:\MySoundDir\Ring.WAV /P /T:60

Start Total Recorder and load a sound file. You can then use the “Play” button to play 
the file:

TotalRecorder  “C:\My folder\My sound file.WAV”

Using the Total Recorder Log

The Total Recorder Log contains a list of all messages relating to jobs scheduled by 
the built-in scheduler or initiated through the command line or auto stop. This log sits 
in the registry and unlimited expansion is not desirable. By default, all records older 
than one week will be automatically deleted.

Some errors cannot be written to the Total Recorder Log, for example, errors when 
writing to the registry and syntax errors in command line parameters. These errors 
will not occur when working with the built-in scheduler.
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To review or control information in the Total Recorder Log, select “View Log” from 
the “File” menu. You are presented with the following dialog:

Message list

The list contains all messages, in chronological order, relating to jobs scheduled by 
the built-in scheduler or initiated through the command line. For each job it includes 
the starting time, ending time, and all error messages. Scheduler messages are marked 
with the letter “S”; command line messages and auto stop related messages are 
marked with the letter “P”. The current message is displayed below the list.

Controls

You can use the following controls from this dialog:

 Auto delete after – controls the automatic deletion of obsolete records. This is
the default mode. Switching it off is not recommended because it will cause 
the registry to grow and decrease system performance.

 Day(s) – records will be deleted after this number of full days. Records are 
deleted at midnight on the expiry date or the next time your computer is on 
after this date. For example, “0” means that only records from the current day 
are accessible, “1” means that records will be kept for one full day and deleted 
at midnight the following day, and so on.

 Clear all – delete all records. Confirmation is required.

 Close – close the dialog. All changes are immediately made.
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KEYBOARD SHORTCUTS
Most control elements have keyboard shortcuts:

Button Shortcut Menu Item

Interrupt work Play/Record - Interrupt work

Recording source 
and parameters

Options - Recording source and parameters...

Mark (left) Shift-L Markers - Set left mark

Go     (left) L Markers - Go to Left mark

       (left) Shift-M Markers - Shift left mark left by 0.1s

       (left) Shift-N Markers - Shift left mark right by 0.1s

UnDo Shift-U Markers - UnDo markers settings

ReDo Shift-D Markers - ReDo markers settings

Mark (right) Shift-R Markers - Set right mark

Go     (right) R Markers - Go to Right mark

       (right) Shift-S Markers - Shift right mark left by 0.1s

       (right) Shift-T Markers - Shift right mark right by 0.1s

Auto Stop     P Markers - Stop playing at the right marker

Save as...             File - Save selection as...

Ctrl-A Play/Record - To Start

Ctrl-L Play/Record - Left by step

Ctrl-T Play/Record - Right by step

Ctrl-Y Play/Record – Play

Ctrl-U Play/Record – Pause

Ctrl-U Play/Record – Continue

Ctrl-P Play/Record – Stop

Ctrl-R Play/Record – Record

no button - only 
in menu

Ctrl-E Play/Record – Play selection
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TROUBLESHOOTING
This section describes problems that may occur and some techniques for diagnosing 
problems. 

Symptom - Unable to Play Simultaneous Sound Streams
After the installation of Total Recorder your computer lost the ability to play several 
sound streams simultaneously. This applies only to some very advanced sound cards 
that are capable of playing multiple streams or if your computer has more than one 
sound card.

Possible Cause #1
During the Total Recorder installation, its driver is set as a preferred device and the 
flag “Use preferred devices only” is set. This flag disables playing multiple sound 
streams. Some programs (e.g. Windows Media Player) need this flag to be set in order
to work correctly with Total Recorder (see next symptom, Possible Cause # 3).

Action #1
Select "Start"-"Settings"-"Control Panel"-"Multimedia" (or from the Total Recorder 
menu, select "Options"-"System settings"), tab "Audio", and uncheck the box "Use 
preferred devices only".  If this causes a problem after recording a program, you will 
need to turn it on during recording and then turn it off when you are done. Or you can 
set mode to turn on the Total Recorder driver only when Total Recorder is running. 
For more information, refer to the "Configuring Total Recorder" - "Using the System 
Tab" section of this document. In this case you should uncheck the "Use preferred 
devices only" flag, in order to turn it off automatically when Total Recorder finishes.

Symptom - No sound recorded
Sound is reproduced but Total Recorder does not record it. The slider remains at the 
left edge and the “Length (sec.)” counter does not change.

Possible Cause #1
Some playback programs do not perform a system inquiry for the default sound 
driver; they explicitly indicate the driver they need. These programs may be older, 
obsolete programs or may use special functions of specific devices. It is not possible 
to set the system to ignore these direct requests and sounds reproduced by such 
programs will not be recorded. 

Action #1
Change the playback program where possible.
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Possible Cause #2
Some programs (e.g. Internet telephony) have the ability to select the necessary audio 
driver manually and ignore system settings.

Action #2
Read the program manual and set the Total Recorder driver as both the driver for 
playing and recording.

Possible Cause #3
Total Recorder's driver perceives a sound stream in main wave-format (PCM, pulse-
coded modulation) only. If the reproducing program sends a sound stream in any other
format (e.g. compressed), Windows usually calls the decoding drivers itself to 
perform all of the required translation. However, if your sound card can make some 
translation at the hardware level, then Windows can direct the sound stream to the 
driver of such a sound card immediately, and bypass Total Recorder's driver. As a 
result, sound cannot be recorded. 

Action #3
Select “Start”-”Settings”-”Control Panel”-”Multimedia” (or from the Total Recorder 
menu, select "Options"-"System settings"), tab “Audio”, and check the box “Use 
preferred devices only”. This eliminates the use of any device other than the default 
one. 

Possible Cause #4
The mode "Preferred audio devices when Total Recorder isn't active" - "Audio 
playback and recording devices selected above" is turned on. In this case, if the 
playing back of the sound you are attempting to record was started before Total 
Recorder was started, the playback program does not use the Total Recorder driver. 
You have changed playback or recording preferred device either manually or it has 
been done after the play back was started.

Action #4
Without closing Total Recorder, close the playback program and restart it. Try to 
make your recording again.  Remember if the mode of automatic driver switching is 
turned on, you should start Total Recorder first and only after that should you start the
playback program from which you are going to record sound.

Symptom - Sound recorded with gaps
Sound is recorded with gaps. The “sec. lost” counter on the “Status” panel has a value 
other than 0.
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Possible Cause #1
Total Recorder does not have enough time to record sound. This can happen on slow 
computers or when a slow device (e.g. a diskette) is used as a destination device for 
the temporary recording file. 

Action #1
Use a faster device for storing temporary files.

Possible Cause #2
The Playback program's buffer is bigger than Total Recorder’s driver buffer. In this 
case all sound will be omitted. The “sec. lost” counter will grow while the “Position 
(sec.)” counter will remain at 0. This situation is extremely unlikely since Total 
Recorder’s buffer should be big enough. 

Action #2
Go to the URL: http://www.highcriteria.com/support.htm.

Possible Cause #3
Your computer is overloaded with other jobs.

Action #3
Select “Options”, “Settings”, “System” tab and enable the “High priority” setting.

Symptom - Sound system or playback programs not working properly
After installing Total Recorder, the sound system or some playback programs are not 
working properly, even when Total Recorder is not active. 

Possible Cause #1
There is an incompatibility with Direct Sound. When a playback program uses Direct 
Sound, the sound can sometimes be garbled. 

Action #1
Many modern programs can be set up to optionally use Direct Sound. Read the 
program’s help to determine the required settings.

Possible Cause #2
The Total Recorder driver is not compatible with other installed programs.

Action #2
Describe your system configuration and the nature of your problem via E-mail to 
High Criteria Inc. This will help eliminate the problem in future releases.
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You cannot record from a conflicting playback program. However, you can eliminate 
the conflict when Total Recorder is not active by using the Total Recorder driver as a 
preferred device only when necessary. This can either be done automatically; each 
Total Recorder starts up and shuts down, or manually. Automatic switching is simpler.

To automatically switch preferred devices:

Use the "Options"-"Settings", "System" tab, and set "Preferred audio devices 
when Total Recorder isn't active" as "Audio playback and recording devices 
selected above". For more information, refer to the “Using the System Tab” 
section of this manual.

To manually switch preferred devices:

1. Leave the default setting for “Preferred audio devices when Total Recorder 
isn’t active” as "Total Recorder driver (recommended)". Total Recorder will 
not switch devices and will not check the settings until it needs some service 
from its driver (i.e. during a recording from source "Software").

2. Use the Windows system dialog (“Start”, “Settings”, “Control Panel”, 
“Multimedia” or “Sounds and Multimedia”, “Audio tab”), or use the Total 
Recorder menu items (“Options”, “System settings”), and select the devices 
that were set before the installation of Total Recorder. If you are unsure what 
to select, review the Total Recorder settings: “Options”, “Settings”, “System” 
tab, “Audio playback and recording devices”.

3. For recording sources other than “Sound board”, you must make either one or
two of the Total Recorder virtual devices (i.e. playback and recording) your 
preferred devices before you start the playback program you would like to 
record. 

 If you record from “Software” and “Record also input stream” is not 
checked, the device "Playback through Total Recorder" must be your 
preferred playback device.

 If you record from “Software” and “Record also input stream” is checked,
the device "Playback through Total Recorder" must be your preferred 
playback device, and the device "Record through Total Recorder" must be
your preferred recording device.

4. If Total Recorder needs a device that is not set as a preferred device when you
start a recording, the recording does not begin and the system dialog pops up.

5. After your recording is finished, you can return the original preferred devices 
so that Total Recorder will not interfere with any other software.
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Diagnosing Problems

If you experience problems with Total Recorder that you cannot resolve yourself, visit
the support area at http://www.highcriteria.com/support.htm. You should read 
Frequently Asked Questions at http://www.highcriteria.com/faq_tr.htm before 
sending a letter to support.

Technical Support may ask you to set the Total Recorder program in debug mode and 
send them a debug file. When advised by Technical Support, take the following steps:

1. Use the configuration menu to select “Driver debugging” and specify the name of 
the debug file you want to use. Total Recorder will write diagnostic information, 
in ASCII format, to this file.

2. Try to reproduce the problem. 

3. As soon as you have reproduced the problem, turn off the debugging option. 
Running in debug mode slows down the operation of the software and takes up 
additional hard drive space. 

4. Send the debug file and a description of the problem to High Criteria. 
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